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Ending the project / transitioning to operations

For CD-4
► KPPs Achieved – FPD
► Readiness to operate / Transition to Operations Review
► CD-4 OPA Independent Project Review
► Final Hazards Analysis Report
► Revised Environmental Management System*
► Draft Project Closeout Report

Final Closeout – Post CD-4
► Finalize PARS-II project Completion
► Final administrative and financial closeout
► Initial Project Closeout Report (≤90 days after CD-4) 
► Project Lessons Learned (≤90 days after CD-4)
► Final Project Closeout Report
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Page 6 of DOE/SC Decision Matrix

*as appropriate
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3Project Closeout Report (SC-28 Template) 

A DOE FPD submitted document 
(like the MNS and Acquisition Strategy (AS) requires significant input from project and laboratory)

► Acquisition Approach
► Project Organization
► Project Baseline at Completion

► Scope
► Cost
► Schedule
► WBS
► Funding Profile
► Staffing Profile
► Environmental 
► Safety Record
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► Closeout Status
► Lessons Learned
► Photos
► Project archives
► Appendices

► Detailed WBS Dictionary
► Detailed Technical Performance
► Major External Reviews
► Detailed Safety Information
► Project Risk Registry
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DOE/SC-OPA Reviewer Checklist

The purpose of CD-4 review is 
to ensure that the project 
goals have been successfully 
completed, lessons learned 
have been captured, and that 
the project is ready for 
closeout.  
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üVerify that the Threshold KPPs have been met.

üVerify the Draft Project Closeout Report with 
lessons learned is complete?

üAre there any contract claims, how much and is 
there sufficient contingency to cover the costs?

üIs there a plan for the remaining project fund 
or contingency to be used?

üIs the project ready for operations? Have all 
the requirements and activities been completed?
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Project Closing Phase
“All’s well that ends well.”   

– Bill Shakespeare, Elizabethan project manager 

“What we call the beginning is often the end. 
And to make an end is to make a beginning. 
The end is where we start from."  

– T.S. Eliot, four quartets
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Project Closing Phase Processes

► Close Project
► Deliverables validation
► Turning over deliverables
► Lessons learned
► Project data files for future reference
► Disposition and placement of project team

► Contract Closure
► Resolution of any open items
► Final settlement of all subcontracts

K.E.Robinson
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Significant intersections

Integration Scope Time Cost Quality Human 
Resources Communications Risk Procurement Stakeholder

Initiating ✔ + + + ✔

Planning ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Executing ✔ ✔ ✔ ✔ ✔ ✔ ✔

Monitoring & 
Controlling ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Closing ✔ + + + + + +

K.E.Robinson
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► Learning happens at the end of the project 
Learning happens throughout the project 
► Called for after failure or high stress 

Planned for any project that is core to business goals 
► One meeting with all participants in one room 

Meetings with smaller task focused groups 
► Reviews the entire process 

Focuses on key issues relevant to going forward 
► Produces a report with recommendations 

Produces an action plan participants will implement 
► Focuses more on dissecting past performance 

Focuses more on planning of future success
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Lessons Learned –
After Action Review (a military perspective)
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► What was supposed to happen?
► What did happen?
► Why did it happen? (don’t point fingers)
► What are your recommendations? (constructive) 
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Lessons Learned –
After Action Review (a military perspective)
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► Near the end of the project the tracking process must be intensified to 
ensure that everything is brought to completion
► In many systems, it is only at the end that it is possible to demonstrate the 

performance has been achieved
► May require prolonged commissioning and testing

► Maintain a complete list of all tasks left to complete (“punch list”)
► Create the list “bottom up” looking at what needs to be done
► Do not just look at the original task list

► This is a reality check – maybe you forgot something at the start

► Keep careful, frequent track of every remaining task
► Follow each task through to completion

► Re-estimate the duration of the work still to be completed
► Do not just copy the original estimates

► Looking at the actual work usually gives a clearer picture

K.E.Robinson
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Project Closeout – Transition to Operations

► With scientific projects and accelerators in particular, 
commissioning and operation at ultimate performance 
shouldn’t define the close of the project

K.E.Robinson
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Project Closeout – Transition to Operations

► As the project approaches its close all stakeholders are strongly vested in 
success
► Project team
► Project manager/director
► Institution
► Funding agency

K.E.Robinson
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13Project Closeout – Agency / Institutional Obligations

► Summary closeout reports are often required (see examples in materials)

► Historical information if preserved in a manner which can be exploited by 
others can serve as a basis of estimate, design, and management for 
future projects

► The goal of closeouts is that projects become better than simply 
repeating stochastic Monte Carlo simulations

K.E.Robinson
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– Take Care of Your Team

► As the end of a project approaches the project team must be 
carefully managed
► Determining planned subsequent assignments
► Phased transitions
► Celebrations of accomplishment
► Lending support to collaborators for follow on work

► Be generous with credit and acknowledgement of contributions
► A project is always a team effort and that team includes the funding 

agency representatives
► The quality of your next project team depends on how well you take 

care of your present team

K.E.Robinson
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► Again:  
“A project has an end, and a sausage has two”

► It is essential to push a project to completion
► The final punch lists, action items, must be hounded
► To be a success, a project must end
► A project that does not end smartly will become an albatross for the 

institution and the project manager

► The final clean up is both physical, managerial, and emotional –
respect all three

K.E.Robinson
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Project Success & 
Failure

“It is better to keep one’s mouth shut and be 
thought of as a fool than open it and remove 
all doubt.” – Abraham Lincoln 

K.E.Robinson
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“There is a time for departure even when 
there's no certain place to go.” 

– Tennessee Williams
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to understanding success in projects

Schedule Cost

Stakeholder ExpectationsRequirements & Quality

Risk & UncertaintyBack to Project 
Graphic #1

Septem
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R2A2s

Scope

Safety
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K.E.Robinson

Project Success: 
Easy to Define – Hard to Achieve

► Dependent variable constraints are met
► Scope
► Cost
► Schedule

► Principal Stakeholder (customer) requirements met
► Identified requirements (needs)
► Unidentified requirements (expectations)

► Quality at an appropriate level
► Organization is improved

Septem
ber 2022



PM-F
19Scope

Institutional 
Goals

Client 
Satisfaction

Risk & 
Uncertainty

Schedule Cost
Roles

Responsibilities

&

Scope

“If you don’t know what you’re doing, 
do it neatly and with style.”

— Author Unknown
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– Key Success Attributes
► Complete Work Breakdown Structure (WBS)
► Established prioritized requirements

► Clearly delineated
► Sufficient detail before engagement
► Specification only to necessary and sufficient

► Controls against scope creep
► Quality of scope deliverables understood

► Clean interfaces
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Institutional 
Goals

Client 
Satisfaction

Risk & 
Uncertainty

Scope

Cost
Roles

Responsibilities

&
Schedule

Schedule
K.E.R

obinson

#74: All problems are solvable in time, so 
make sure you have enough schedule 
contingency—if you don't, the next 
project manager that takes your place will.
— 100 Rules for NASA Project Managers
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– Key Success Attributes

► Realistic 
► Dependencies understood

► Exploding

► Integrating

► Adequate float/contingency in schedule

► Phased detail
► Critical and near critical activities understood
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Institutional 
Goals

Client 
Satisfaction

Risk & 
Uncertainty

Scope

Schedule
Roles

Responsibilities

&
Cost

The same work under the same conditions will be 
estimated differently by 10 different 
estimators or by 1 estimator 10 different times.
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– Key Success Attributes

► Completeness
► Quality of estimates understood
► Uncertainty understood
► Cost risks understood
► Contingency

► Explicit
► Centrally controlled 
► Adequate
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Institutional 
Goals

Risk & 
Uncertainty

Scope

Schedule Cost
Roles

Responsibilities

&

Stakeholder
Expectations
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— Key Attributes

► Understanding who are the stakeholders
► Clear identification
► Open Communication
► Requirements
► Continued Involvement
► Clarity of deliverables
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Client 
Satisfaction

Risk & 
Uncertainty

Scope

Schedule Cost
Roles

Responsibilities

&

Requirements
& Quality
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– Key Attributes

► Requirements, Constraints, and Assumptions clearly understood
► Quality matched to

► Fitness of purpose
► Good enough

► Established at inception emphasized during project design and development
► Does not attempt to inspect or rework quality in after execution
► Matches quality rigor to the characteristics

► Critical
► Major 
► Minor
► Incidental
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Institutional 
Goals

Client 
Satisfaction

Scope

Schedule Cost
Roles

Responsibilities

&

Risk & 
Uncertainty

Y = Set of all projects 
X = Subset of projects that are 100% 

known & executed as planned

X = Ø (null set) Septem
ber 2022
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– Key Attributes

► Acceptance
► Understanding the nature
► Active feedback management
► Prioritized effective mitigation
► Exploitation
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Institutional 
Goals

Client 
Satisfaction

Risk & 
Uncertainty

Scope

Schedule Cost
Roles

Responsibilities

&
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– Key Attributes

► Governance clearly established and understood

► Authority is delegated

► Decision process understood

► Change management firmly established

► Interfaces / handoffs clean, obvious, communicated
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Trust and Communication

► All of the PM tools designed to illuminate and facilitate 
communication of project directions and goals

► Except 1-person projects, all projects need communication for 
success

► Without a basis of trust, project leadership cannot function
► Meaningful delegation not possible
► Individual authority not given
► Responsibility not accepted

K.E.Robinson
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Summary
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Scope
Sc

he
du

le C
ost

Stakeholder Expectations Requirements & Quality

Risk & Uncertainty

K.E.Robinson
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Safety
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► All projects have risk and uncertainty
► All projects have 5 process groups

1. Initiating
2. Planning
3. Executing
4. Controlling
5. Closing

► All projects have a client / key stakeholder 
► All projects exist in a context that must be understood
► All projects necessarily require teams

► Clear roles and responsibilities
► Effective delegation
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knowledge areas at all phases of a project
There is no firm boundaries between areas or any set phases when they aren’t needed
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Scope

Time Integration

Cost
Quality Human Resources

Communication

Stakeholder

Procurement

Risk

Initiation
Planning Execution

Closing
Monitoring & Control
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PARS II Reporting

Earned Value Reporting

This applies throughout the DOE 413.3B Project Timeline
Septem

ber 2022
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Conceptual
Design

Preliminary
Design

Detailed
Design Construction / ExecutionInitiating 

Project

Closing 
the 

project

Mission Need Statement

CD-0
Approve Mission 
Need

CD-1
Approve Alternative 
Selection and Cost Range

Federal Project Execution Plan
Acquisition Strategy
Tailoring Strategy
Integrated Project Team Charter
Conceptual Design Report
Preliminary Hazard Analysis Report
Other Documents

CD-2
Approve Performance Baseline

Project Management Plan
Performance Baseline
Technology Readiness Assessment
Preliminary Design Report
Updates to ALL Documents

CD-3 
Approve Start of Construction

Final Design Report
Final Security Assessment
Project Safety & Health Plan
Updates to ALL Documents

CD-4
Project 
Completion

Documented Safety Analysis
Technical Safety Requirements
Transition to Operations Plan
Verify Key Performance Parameters
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► Evolved as a result of the risks realized and challenges faced by DOE with its 
portfolio

► Formalized the phased development and critical decision (phase gate)
► CD-0 Mission Need = Business Case
► CD-1 Approve Alternative = Conceptual design / Requirements & Scope
► CD-2 Performance Baseline = Fixing the dependent variables of the project
► CD-3 Approve Start of Construction
► CD-4 Project Completion / Transition to Operations
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https://science.osti.gov/opa/Project-Management/Processes-and-Procedures

https://science.osti.gov/opa/Project-Management/Processes-and-Procedures
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► Distills everything into a 
compact matrix
► Authorities
► Approvals
► Applicability
► Responsibility

► A very good checklist 
once a basic 
understanding is in place

– The Project Decision Matrix
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https://science.osti.gov/-/media/opa/pdf/processes-and-procedures/project_decision_matrix.pdf

https://science.osti.gov/-/media/opa/pdf/processes-and-procedures/project_decision_matrix.pdf
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DOE Order 413.3B defines both technical 
deliverables (design documents, 
occupational safety, etc…) as well as 
management requirements to be used 
throughout the life of the project. 

Technical and management requirements 
must be met before approval to proceed 
beyond a Critical Decision point is granted. 

It is based on general best practices, 

Simple adherence ≠ Success
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Questions and Discussion
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https://science.osti.gov/opa

https://science.osti.gov/opa/Project-Management

https://www.directives.doe.gov/

https://www.energy.gov/projectmanagement/office-project-management

Kem Robinson
Kem.Robinson3@gmail.com
510-590-1010

https://science.osti.gov/opa
https://science.osti.gov/opa/Project-Management
https://www.directives.doe.gov/
https://www.energy.gov/projectmanagement/office-project-management
mailto:Kem.Robinson3@gmail.com
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Thank you
…
May the funding come when you need it,
May the risks all be addressable,
May the scope be controllable,
May the schedules be realizable,
May the sun shine warm upon your face,
And the rain fall softly on your fields 
Until we meet again…

– Irish project management blessing (paraphrased)
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